
РАЗРАБОТКА 
ПРОЕКТА 
ПЕЧАТНОЙ ПЛАТЫ



РАЗРАБОТКА ЭЛЕКТРИЧЕСКОЙ СХЕМЫ

⦿ При реализации проектов печатных плат 
работа начинается с формирования идеи 
разработчика в виде принципиальной 
схемы. Формирование новой 
электрической схемы начинается с 
создания нового файла проекта и листа 
схемы командами File>New>Project>PCB 
Project и File>New>Schematic. После 
создания новых документов их следует 
сразу же сохранять. Для сохранения 
проекта выполняется File>Save Project As, а 
для схемы – File>Save, например, присвоим 
проекту и схеме название Study. В 
результате в окне документов появляется 
лист схемы (по умолчанию формат А4), а в 
панели Project будет отражена структура 
проекта, как показано на рисунке. 



НАСТРОЙКА РЕДАКТОРА СХЕМ

⦿ Настройки в AD можно разделить на глобальные – относящиеся ко 
всем документам и локальные – относящиеся только к текущему 
документу. Некоторые из настроек дублируются в двух местах (как, 
например, сетки и единицы измерения), и отличаются только 
областью применения.

⦿ Настройки текущего документа настраиваются на вкладке 
Design>Document Options. 



НАСТРОЙКА РЕДАКТОРА СХЕМ

⦿ Для начала во вкладке Units нужно указать систему единиц 
измерения, выбираем метрическую, при этом настройка будет 
действовать только на открытый документ.

⦿ В поле Template указываем имя текущей форматки, в поле Standard 
Style выбираем размер листа из стандартных.

⦿ Поле Options: 

⦿ Orientation – ориентация листа, выбирается из двух значение, 
Landscape (альбомная) и Portrait (Книжная);

⦿ Title Blok – показывать стандартную рамку листа, которая может 
использоваться совместно с пользовательской, что не совсем удобно;

⦿ Show Reference Zone – показывать зоны разметки, в виде буквенно-
цифровых обозначения по границам листа.

⦿ Show Border – показывать границы листа;

⦿ Show Template Graphics – показывать стандартный штамп (форматку);

⦿ Border color и Sheet color – цвет границы листа и цвет листа.



НАСТРОЙКА РЕДАКТОРА СХЕМ

⦿ В поле Grids (Сетки) выбираем шаг сетки и видимость сетки. Electrical 
Grid (электрическая сетка) – область вокруг вывода компонента, за 
которую «цепляется» цепь при соединении компонентов. Значение 
данного параметра должно быть в 2 раза меньше чем минимальный 
шаг расположения выводов УГО, чтобы области двух соседних 
выводов не пересекались между собой. Нажатием кнопки ОК 
подтверждаем выбранные настройки. Кнопка Change System Font 
(поменять системный шрифт) используется для надписей, 
привязанных к некоторым объектам по умолчанию (например, имя 
(Pin Name) и номер (Pin Des) вывода, имя порта). Изменив этот 
параметр на данной вкладке, величина указанных надписей изменится 
во всем документе.

⦿ В поле пользовательских настроек Custom Style активизировать 
настройку пользовательского формата – опция Use Custom Style и 
назначить размеры листа по горизонтали и по вертикали. При этом 
необходимо руководствоваться следующим. Зонная разметка должна 
быть сохранена для того, чтобы впоследствии, в схеме, была 
возможность перенумерации позиционных обозначений.



НАСТРОЙКА РЕДАКТОРА СХЕМ

⦿ Глобальные настройки редактора находятся в меню 
DXP>Preferences>Schematic. Для начального ознакомления оставим 
все параметры по умолчанию.



СОЗДАНИЕ СХЕМЫ

⦿ Создадим схему мультивибратора.

⦿ Начнем с добавления компонента в схему через Главное меню 
Place>Part…(Горячие клавиши P,P).

⦿ Здесь Placement Type – From Standard Libraries оставляем, будем 
пользоваться встроенными библиотеками. Жмем кнопку с тремя 
точками, чтобы выбрать библиотеку, компонентами нужно 
использовать.





СОЗДАНИЕ СХЕМЫ

⦿ В поставке AD идут две стандартные 
библиотеки компонентов: 
Miscellaneous Devices.IntLib и 
Miscellaneous Connectors.IntLib. Это 
интегрированные библиотеки, т.е. 
содержащие и символы, и 
посадочные места. Если пакет 
установлен по умолчанию, то они 
находятся по адресу 
C:\Users\Public\Documents\Altium\

AD14\Library\Miscellaneous Devices.IntLib

⦿ Появилось окно выбора библиотеки 
компонентов. Сверху окна видно 
наименование библиотеки, появился 
список компонентов и справа 
символ, и посадочное место. Здесь 
выбираем подходящий компонент 
(2N3904) и жмем ОК.



СОЗДАНИЕ СХЕМЫ
⦿ Возвращаемся в окно выбора 

компонентов (рисунок 2.6). Здесь уже 
заполнены все поля и есть 
возможность изменить некоторые 
параметры, например, позиционное 
обозначение или тип посадочного 
места. Знак вопроса в позиционном 
обозначении – служебный символ, 
необходим для автоматической 
нумерации. Вместо него можно сразу 
поставить номер, но не нужно.

⦿ Жмем ОК. После выбора компонента в 
библиотеке он "прикрепляется" к 
курсору. Сейчас можно вызвать окно 
свойств компонента, нажав кнопку 
Tab, однако, если мы изменим его 
свойства, последующие компоненты 
будут их наследовать до выбора 
следующего. 

⦿ Установка компонента производится 
нажатием левой кнопки мыши в 
нужном месте рабочего поля. После 
установки компонент по прежнему 
"прикреплен" к курсору и есть 
возможность установить еще один 
такой же.



СОЗДАНИЕ СХЕМЫ

⦿ Если требуется зеркальная копия компонента, то жмем кнопку X на 
клавиатуре. Устанавливаем компонент.

⦿ Так как больше транзисторы не нужны, переходим к выбору 
компонентов в библиотеке, для чего жмем правую кнопку мыши и 
возвращаемся в окно выбора компонентов. Выбираем резистор и 
устанавливаем горизонтально. Следующий нужно повернуть на 90 
градусов, для этого жмем пробел. Повторяем операцию для 
конденсаторов и разъема, который находится в другой библиотеке.



СОЗДАНИЕ СХЕМЫ
⦿ Закрыть окно выбора компонентов можно кнопкой Esc. Передвигать 

рабочее поле можно "зацепив" его правой кнопкой мыши за свободное 
от элементов место, но этот режим не работает, если мы выбрали 
компонент. В этом случае можно подтянуть курсор с прикрепленным к 
курсору компонентом к нужному краю экрана и рабочее поле плавно 
передвинется. Масштабируется изображение стандартно – колесиком 
мыши при нажатой кнопке Ctrl. Компоненты можно передвинуть 
"зацепив" их левой кнопкой мыши, при этом их можно повернуть и 
сделать зеркальными. 

⦿ Для прокладки проводников идем в Главное меню Place>Wire. 
Подводим курсор к выводу компонента, где он подсвечивается 
диагональным красным крестом, что означает возможность сделать 
соединение, как показано на рисунке.



СОЗДАНИЕ СХЕМЫ

⦿ Далее жмем левую кнопку мыши, и тянем проводник до следующего 
вывода. Если проводник тянется не так, как хотелось бы, то 
поворачиваем его пробелом, так же как и компонент. Сменить угол 
прокладки проводника с 90º на 45º можно сочетанием клавиш 
Shift+пробел. Если на одной линии прокладки стоят несколько 
компонентов, то проводник можно тянуть до следующего, а 
предыдущий автоматически «прицепится» к прокладываемому 
проводнику.

⦿ По умолчанию при попытке перемещения проводника, его сегмент (от 
одного угла или вывода компонента, до другого) "отрывается" от 
компонентов и, если он изначально рисовался как сегмент, 
проводника. Для того чтобы проводник или компонент тянули за собой 
проводники перед перемещением нажимаем кнопку Ctrl и 
удерживаем ее во время перемещения.

⦿ Символ земли добавляем через Главное меню Place>Power Port, 
который автоматически именует присоединенную цепь. Добавить имя 
для других цепей можно, поставив ярлык через Главное меню 
Place>Net Label.



СОЗДАНИЕ СХЕМЫ

⦿ При любом внесении 
изменений необходимо 
постоянно сохраняться. 
После каждого нажатия на 
кнопку Save система создает 
резервную копию схемы или 
платы, архивирует ее и 
складывает в папку History 
папки проекта.

⦿ Позиционные обозначения 
AD позволяет проставить 
автоматически. Позиционные 
обозначения проставим 
методом ECO (Engineering 
Change Order). С помощью 
ECO можно отследить 
достаточно много ошибок, 
причем до производства 
каких либо действий. На 
этом этапе, так же, можно 
сформировать отчеты для 
более подробного изучения. 
Идем в Главное меню 
Tools>Annotate Schematics. 
Получаем окно расстановки 
позиционных обозначений



СОЗДАНИЕ СХЕМЫ
⦿ Сначала выбираем порядок 

расстановки (отмечен 
стрелкой) – Down Then Across, 
картинка под списком 
наглядно показывает процесс. 
Далее жмем Update Changes 
List. Всплывающее окно 
информации показывает, 
сколько позиционных 
обозначений обновлено.

⦿ Теперь в окне справа мы 
видим изменения в списке – 
колонка Proposed. Если все 
устраивает, а оно устраивает – 
жмем Accept Changes (create 
ECO). Только сейчас 
изменения вносятся в схему. 
Мы получаем окошко со 
списком изменений, которые 
должны быть внесены в 
схему.

⦿ Жмем кнопку Validate 
Changes, и система проверяет 
возможность внесения 
изменений без ошибок. После 
жмем кнопку Execute Changes.



СОЗДАНИЕ СХЕМЫ
⦿ По умолчанию сортировка 

компонентов производится 
по полю Comment, но 
правило можно изменить. В 
процессе простановки 
позиционных обозначений 
необходимо обратить 
внимание на количество 
обновленных позиционных 
обозначений относительно 
количества компонентов в 
схеме. Если у одного или 
нескольких компонентов уже 
проставлены позиционные 
обозначения, то они 
обновлены не будут. 
Поэтому некоторые 
позиционные обозначения 
можно проставить вручную. 
В случае необходимости 
обновления всех 
позиционных обозначений, 
их необходимо 
предварительно сбросить. 
Эта операция повторяет 
аннотацию, только вместо 
кнопки Update Changes List, 
жмем Reset All



СОЗДАНИЕ СХЕМЫ

⦿ В результате у каждого 
компонента видны три 
атрибута: позиционное 
обозначение, комментарий, 
номинал. У транзисторов, по 
понятной причине – номинал 
отсутствует. Изменить 
атрибуты можно прямо на 
схеме. Двойной клик на 
номинале вызовет окно 
свойств атрибута. Все 
атрибуты для компонента 
можно изменить в окне 
свойств компонента, дважды 
кликнув на компоненте. 
Основные указаны стрелками 
- это позиционное 
обозначение и комментарий 
с флажками видимости, 
номинал, посадочное место.



СОЗДАНИЕ СХЕМЫ

⦿ Изменяем необходимые. Далее, для красоты, можно подвигать 
атрибуты. Однако для этого необходимо уменьшить шаг сетки, для 
чего жмем  View>Grids> Set Snap Grid… В окошке выбора шага сетки 
меняем значение на 5. Предыдущее значение шага сетки осталось в 
стеке, и межу ним и новым значением можно переключаться 
клавишей G. Текущее значение выводится в строке состояния в левом 
нижнем углу. Для более точной установки атрибутов "цепляем" их 
мышкой и тянем на нужное место. После этого можно скрыть 
комментарии у резисторов и конденсаторов, через окно свойств, и 
готовую схему сохранить. Для больших схем на помощь приходит  
инспектор. Это инструмент для правки групп параметров.



СОЗДАНИЕ СХЕМЫ

⦿ Практически все операции в AD 
выполняются с помощью запросов. 
Инспектор, это, по сути, 
построитель запросов. Параметры в 
нем можно задавать вручную, или 
можно воспользоваться мастером. 
Отдельно он вызывается клавишей 
F11 или выделяем на схеме 
атрибут, щелкаем на нем правой 
кнопкой мыши и выбираем Find 
Similar Objects...

⦿ В результате получаем окошко – 
мастер ввода параметров, в 
котором выбираем параметры 
запроса, точнее изменяем по 
необходимости.



СОЗДАНИЕ СХЕМЫ

⦿ В нашем случае меняем 
параметры совпадения в Object 
Specific Value и Object Specific 
Parameter Name с Any (Любой) 
на Same (Одинаковый). Т.е. 
получается, что мы выбираем 
все комментарии с именем Res1. 
Ставим галочку Select Matching 
(выбрать все подходящие). 
Далее нажимаем Apply 
(Применить), на схему будет 
"наложена" маска, 
подсвеченными останутся только 
комментарии для резисторов. 
Проверяем, чтобы стояла 
галочка Run Inspector.

⦿ Смотрим на схему - все ли 
выделилось, жмем OK. 
Запустится SCH inspector. Здесь 
ставим галочку Graphical>Hide и 
смотрим на результат.

⦿ Закрываем инспектор и в правом 
нижнем углу программы жмем 
кнопку Clear, чтобы отменить 
маскирование.



СОЗДАНИЕ СХЕМЫ

⦿ Схема готова, и её можно передать на плату. Но для подготовки 
схемы мы воспользовались интегрированной библиотекой, а 
изменение/добавление компонентов библиотеки не допускается, что 
ограничивает возможности редактирования схемы. Чтобы обойти это 
ограничение, создадим свои библиотеки.

⦿ Нужно отметить, что в схеме содержится полная информация о 
компоненте и её можно получить из схемы. Таким же путем возможно 
изменять компоненты прямо на схеме, например, назначение и имена 
выводов, ссылку на посадочное место и другие, но это придется 
делать для каждого компонента отдельно. Но многие параметры 
(например, графическое изображение) изменить на схеме нельзя. 
Поэтому необходимо создать свои библиотеки.

⦿ Воспользуемся схемой, как заготовкой будущей библиотеки. В 
оболочке AD может быть открыто несколько документов. Все действия 
производятся в текущем, в зависимости от этого меняется состав 
главного меню и панелей. Идем в Главное меню Design>Make 
Schematic Library. Извлекаются символы из схемы, и создается 
библиотека (схемная). Появляется боковая панель – SCH Library и 
открывается первый по списку символ для редактирования. Окошко 
информации подсказывает, сколько извлечено символов из схемы.





СОЗДАНИЕ СХЕМЫ

⦿ Но библиотека, как 
таковая, еще не 
прописана в проекте и 
связи еще не 
обновлены. Об этом, 
косвенно, говорит 
отсутствие вида 
посадочного места в 
окошке просмотра.

⦿ Теперь необходимо 
вернуться к дереву 
проектов. 
Переключение между 
открытыми панелями 
осуществляется с 
помощью закладок. В 
дереве проекта 
появилась библиотека 
символов. Сохраняем 
библиотеку 
аналогично 
сохранению проекта и 
схемы.



СОЗДАНИЕ СХЕМЫ
⦿ ОБЯЗАТЕЛЬНО после каждого 

внесения изменений в 
библиотеку её нужно 
сохранить, только после этого 
изменения вступают в силу. 
Возвращаемся к панели SCH 
Library. Заменим компоненты в 
схеме на только что 
созданные. Для этого щелкаем 
правой кнопкой мыши на 
названии компонента в 
боковой панели и выбираем в 
контекстном меню Update 
Schematic Sheets

⦿ Информационное окошко 
сообщит нам о количестве 
замененных компонентов, 
здесь не лишним будет 
"прикинуть", все ли обновилось 
и на тех ли схемах.

⦿ Изменения вносятся в 
открытые документы. 
Заменяются компоненты с 
совпадающими именами.



СОЗДАНИЕ СХЕМЫ

⦿ Проверить результат 
можно с помощью 
инспектора (вызывается 
клавишей F11). Выделяем 
компонент и смотрим в 
инспекторе поле Object 
Specific Library, в нем 
должно быть имя вновь 
созданной библиотеки.



СОЗДАНИЕ СХЕМЫ

⦿ Так как мы заменили в 
схеме все элементы из 
интегрированной 
библиотеки, на элементы из 
схемной, то это 
подразумевает поиск 
библиотеки посадочных 
мест, которая еще не 
создана.

⦿ В окне библиотеки 
открываем панель 
SCHLibrary. Щелкаем 
дважды по названию 
элемента. В окне свойств 
смотрим на окошко 
предварительного просмотра 
посадочного места. В нем 
пусто, что косвенно говорит 
о проблеме с поиском 
посадочного места. 
Выделяем имя посадочного 
места и жмем кнопку Edit. В 
окне выбора посадочного 
места снова смотрим в окно 
предварительного 
просмотра.



СОЗДАНИЕ СХЕМЫ
⦿ Изменим состояние переключателя PCB Library 

с Use footprint from in на Any, тем самым, 
разрешив поиск подходящего посадочного 
места во всех подключенных библиотеках. И, 
несмотря на пропавшее изображение 
посадочного места, закрываем окошко. 
Повторяем действие для остальных элементов. 
Сохраняем библиотеку. Обновляем компоненты 
в схеме.

⦿ Кратко горячие клавиши:
⦿ Space – поворот компонета или угла;
⦿ Shift+Space – смена угла прокладки трассы или 

цепи;
⦿ X – зеркальное отображение компонента;
⦿ G – переключение между сетками 

перемещения;
⦿ F11 – вызов инспектора;
⦿ Ctrl+Mouse Wheel – масштабирование 

изображения
⦿ Нажатая клавиша Shift – позволяет выделить 

несколько компонентов;
⦿ Нажатая клавиша Ctrl - позволяет переместить 

компонент без отрыва от цепи или трассы;
⦿ Клавиша Tab при установке компонента или 

прокладке проводника вызывает окно свойств.



ПОДКЛЮЧЕНИЕ КОННЕКТОРА К ШИНЕ



⦿ 1. С помощью команды Place/Bus Entry устанавливаем необходимое 
количество выходов на шину (опция не работает, если «шина» 
выполнена командой Place/Wire, а не Place/Bus)



⦿ 2. С помощью команды Place/Wire производим электрическое 
соединение коннектора с выходами на шину



⦿ 3. Используя команду Place/ Net Label обозначаем входы / выходы на 
шину (точка крепления метки должна находиться приблизительно в 
середине выхода на шину) и вводим необходимую нумерацию 
двойным щелчком по надписи NetLabel



ПРОВЕРКА СХЕМЫ

⦿ Заключительным этапом разработки схемы является компиляция 
проекта. В процессе компиляции окончательно выстраивается 
логическая структура проекта. Выявляются ошибки, допущенные при 
составлении электрической принципиальной схемы.

⦿ Для простого одноуровневого проекта, с несложной однолистовой 
схемой, может оказаться достаточным визуальный контроль в ходе и 
по окончании формирования документа. В сложном иерархическом 
проекте ошибки могут ускользнуть от визуального контроля. Чтобы 
этого не происходило, в Altium Designer заложена развитая система 
контроля ошибок.



ПРОВЕРКА СХЕМЫ

⦿ Перед компиляцией 
следует выполнить 
настройки функций 
контроля. Настройки 
выполняются в 
диалоге, 
активизируемом 
командой главного 
меню 
Project>>Document 
Options. Открывается 
диалоговое окно 
Options for 
Project<имя 
проекта>.PrjPcb с 12 
панелями-вкладками, 
на которых 
перечислены все 
возможные признаки, 
по которым 
выявляются ошибки 
проекта.



ПРОВЕРКА СХЕМЫ

⦿ В плане компиляции, нас больше всего могут интересовать настройки, 
призванные выявить нарушения правил соединения компонентов 
линиями электрической связи и соответствие обозначений цепей, 
портов, соединителей листов, в случае многолистового проекта.

⦿ На вкладке Error Reporting назначается характер реакции программы 
на обнаруженные нарушения:

⦿ • No Report – не включать обнаруженное нарушение в отчет;

⦿ • Warning – вывести предупреждение;

⦿ • Error – вывести сообщение об ошибке;

⦿ • Fatal Error – вывести сообщение о фатальной ошибке, при которой 
невозможно выполнение операции.

⦿ Чтобы установить уровень всех нарушений в значение Error следует 
нажать правой кнопкой мыши в любом месте окна и выбрать All Error.



ПРОВЕРКА СХЕМЫ

⦿  Все типы нарушений на вкладке Error Reporting разбиты на группы, по 
отношению к определенному типу объектов, варианты их отображения 
и рекомендуемые настройки:

⦿ 1. Violations Associated with Buses - предупреждения, связанные с 
шинами.

⦿ Violations Associated with Symbols– предупреждения, связанные с 
символами.

⦿ 2. Violations Associated with Components – предупреждения, связанные 
с компонентами.

⦿ 3. Violations Associated with Configuration Constrains – предупреждения, 
связанные с ограничениями конфигурации.

⦿ 4. Violations Associated with Documents – предупреждения, связанные с 
документами.

⦿ 5. Violations Associated with Harnesses – предупреждения, связанные со 
жгутами.

⦿  6. Violations Associated with Nets – предупреждения, связанные с 
цепями.

⦿ 7. Violations Associated with Others, Violations Associated with 
Parameters – предупреждения, связанные с параметрами и другие.



ПРОВЕРКА СХЕМЫ

⦿ На вкладке Connection Matrix 
определяются правила проверки 
электрических соединений схемы, и 
назначается уровень реакции 
программы на различные виды ошибок 
– такие как соединение выхода с 
выходом, выхода с питанием, 
двунаправленного вывода компонента с 
выходным и т.п. На пересечении 
столбцов и строк матрицы стоят 
цветные метки, обозначающие реакцию 
программы на соответствующее 
соединение, обнаруженное при 
проверке схемы. Выбирая 
соответствующую метку, можем 
назначить один из четырех уровней 
реакции – отсутствие реакции (если нет 
ошибки), предупреждение, сообщение 
об ошибке, фатальная ошибка. 
Каждому уровню соответствует свой 
цвет – от зеленого до красного.



ПРОВЕРКА СХЕМЫ
⦿ Вкладка Class Generation – правила формирования классов цепей и 

компонентов. При желании можно отключить формирование комнат и 
классов компонентов согласно подлистам схемы.



ПРОВЕРКА СХЕМЫ

⦿ На вкладке Comparator настраиваются правила проверки соответствия 
имен одинаковых объектов, цепей на листах многолистового проекта 
и целого ряда других возможных ошибок.



ПРОВЕРКА СХЕМЫ

⦿ Вкладка ECO Generation – настройки отчета о перечне изменений. 
Выбираются те изменения, которые следует включить в отчет; по 
умолчанию включены все опции – изменять эти данные 
нецелесообразно.



ПРОВЕРКА СХЕМЫ
⦿ Вкладка Options – группа дополнительных настроек проекта. Здесь 

задаются директории сохранения отчета о компиляции, компарации и 
т.д. В группе Output Options выбираются действия, которые следует 
применить после выполнения процесса компиляции.



ПРОВЕРКА СХЕМЫ

⦿ Вкладка Multi Channel – задает порядок номерации компонентов при 
реализации многоканальных и иерархических проектов.



ПРОВЕРКА СХЕМЫ

⦿ Вкладка Default Prints – настройки распечатки документации проекта.



ПРОВЕРКА СХЕМЫ
⦿ Вкладка Search Paths – расположение библиотек, в которых по 

умолчанию будет проводиться поиск компонентов.



ПРОВЕРКА СХЕМЫ

⦿ Вкладка Parameters – параметры проекта, которые могут быть 
использованы для составления текстовых надписей, являющихся 
общими для всех документов проекта.

⦿ Компиляция проекта выполняется по команде главного меню Project>> 
Compile Document <имя_схемы>.SchDoc. Если при компиляции 
обнаружены ошибки, сообщения об ошибках выводятся на панель 
Messages. В этом случае следует проанализировать сообщения, внести 
в схемный документ необходимые изменения и повторить компиляцию 
проекта. Схемный документ, откомпилированный без ошибок, может 
быть передан на проектирование печатной платы.


